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 صندلی                                                                                            به نام خداشماره         

 آموزش وپرورش شهرستانهای استان تهراناداره کل 

 مدیریت آموزش وپرورش شهرستان قدس

  14۰1- 14۰۲سال تحصیلی   خردادماه امتحانات  

 1هنرستان کاردانش شهید آوینی

  اتوماسیون ادارینام درس: کاربر           کلاس/پایه:             رشته: تصویر سازی دیجیتال        نام دبیر :             نام ونام خانوادگی:                                     

     4از  1صفحه :                    8:3۰ساعت شروع :       دقیقه             8۰مدت امتحان:              14۰۲/ ۰3  /۲۰تاریخ امتحان: 

               امضاء دبیر : :                               نمره با حروف  :                                                                       تاریخ و نمره با عدد

هد ماند )سختی(  آنکه ساعتی خواری  بارم تحمل نکند، همیشه در خواری و نادانی خوا
مبر اکرم   .آموختن را   ردیف )ص(پیا

۲ 

 شود؟از کدام گزینه استفاده می  Wordدر  برای درج شماره صفحات

      Insert > Page Layout  (ب                                     Format > Page Layout (الف  

 Insert > Page Number  (د                                      Format > Page Number (ج  

1 

۲ 
  که یک خانه را به چند خانه فرعی تقسیم کنیم از کدام گزینه استفاده می کنیم؟ برای این

 Select Row( د                     Split Cells(ج           Table Auto Format ( ب                  Merge Cell( الف
۲ 

۲ 
 .را تنظیم کنیم......................  برای ایجاد شیرازه جهت سیمی یا صحافی کردن صفحات باید

  Header( د                         Gutter (ج                                 Footer ( ب                         Margin( الف
3 

۲ 
  کند؟گذاری صفحات( کدام قسمت محل چاپ شماره صفحه را تعیین میشماره) Page Number از پنجره

 Format( د           Show Number On First Page (ج                            Preview ( ب                       Position( الف
4 

۲ 
  را انتخاب می کنیم؟  Border And Shading ایجاد کادر دور صفحه کدام تب از پنجره زمان

 .امکان پذیر نیست( د                         Shading (ج                     Page Border ( ب                        Borders( الف
5 

۲ 
 ؟شوداستفاده می  Tabاز کدام قسمت برای خط راهنما بین دو  Tabs در پنجره

 Leader( د                     Alignment (ج                      Default Tab (ب                      Tab Stop( الف
6 

۲ 
 شود؟کتر یا پاراگراف دیگر استفاده میاکتر یا پاراگراف مورد نظر به کارابندی کاراز کدام ابزار برای کپی قالب 

 Replace( د            Format Painter (ج                         Clip Board (ب                             Copy (الف
7 

۲ 
 کند؟دار میکدام گزینه متن را سایه  Font پنجره در

 Shadow( د                        Out Line (ج                              Engrave (ب                        Emboss (الف
8 

۲ 
  گردد؟شد مشاهده می در کدام حالت نمایش چگونگی چاپ متن، گرافیک و سایر اجزای صفحه را بصورتی که چاپ خواهند

 Out Line( د                          Normal (ج                      Print Layout (ب                Web Layout(الف
9 

۲ 
 .کافی است کلید .............. را فشار دهیم  Wordبرای ایجاد یک صفحه جدید در برنامه

 Back Space( د                             Enter (ج                            Spacebar (ب                Ctrl + Enter (الف
1۰ 

۲ 
 چیست؟ Word پردازنام پیش فرض سند خالی برنامه واژه

 Database( د                   Document (ج                    Presentation (ب                            Book (الف
11 

۲ 
 .شود................ استفاده میبرای بستن پاراگراف در متن جاری و ایجاد یک پاراگراف جدید از کلید ... 

 Shift( د                      Spacebar (ج                                  Enter (ب               Background (الف
1۲ 

۲ 
 شود؟از کدام گزینه زیر استفاده می  Word در سندهایجهت درج علائم ویژه 

 Insert¦Bullets ( د         Insert¦Character (ج                Insert¦Symbol( ب           Insert¦Format( الف
13 

۲ 
 شود؟از کدام گزینه برای افزودن جدول به اسلاید استفاده می

  دتوان به اسلاید اضافه کرجدول را نمی(د         Insert/Diagram(ج           Insert/Table( ب        Insert/ New Slide( الف 
14 

۲ 
 برای خاتمه دادن به نمایش اسلایدها کدام کلید را باید فشرد؟

 Ecs( د                                 Home (ج                                        E (ب                                End (الف    
15 

محل درج مهر 

 هنرستان 

محل درج مهر 

 هنرستان 
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۲ 
 توان متن، تصویر و یادداشت به اسلاید اضافه کرد؟در کدام یک از نماهای زیر می

  Slide Show( د                               Normal (ج                            Outline( ب                  Slide Sorter( الف  
16 

۲ 
 ؟شوداسلایدها در کدام نوار نمایش داده می تعداد کل

 د( نوار ابزار                               ج( نوار منو                           ب( نوار عنوان                                 نوار وضعیت (الف
17 

۲ 
 ؟ اسلاید ایجاد کردتوان یک کپی از اسلاید را بعد از همان با فشار کدام کلیدها می

 Ctrl + D( د                               Ctrl + V (ج                            Ctrl + X( ب                                    Ctrl + C( الف  
18 

۲ 
 توان وارد کرد؟را می، کدام گزینه زیر زمان تاخیر برای حرکت موضوع  Timingو در سربرگ  Custom Animationدر کادر

   Repeat( د                                 Speed (ج                                Delay( ب                                       Start( الف  
19 

۲ 

فونت، اندازه فونت و.... را دار اسلایدها از قبیل های نشانهتوان شکل ظاهری لیستمی  Slide Master در کدام قسمت از

 تغییر داد؟

  Second Level( د            Master Text Style (ج                     Third Level( ب               Master Title Style( الف 

۲۰ 

۲ 
 رود؟های زیر برای اضافه کردن اسلاید جدید به کار میکدام یک از گزینه

    Alt+s( د                                 Ctrl + I (ج                           Ctrl + M( ب                                  Ctrl + N( الف  
۲1 

۲ 
 توان استفاده نمود؟از کدام گزینه برای درج تصاویر درون اسلاید می

 From File( د                          Word Art (ج                        Insert File( ب                                   Clipart( الف  
۲۲ 

۲ 
 ............... گویند را  هایی جهت درج متن و تصویر می باشنداسلایدهای خالی که شامل محل

  Blank Slide( د                      Slide Outline (ج                 Slide Master( ب                         Slide Layout(الف 
۲3 

۲ 
 ؟رودبرای اضافه کردن فقط اسلاید عنوان بکار می  Slide Layout کدام گزینه درقسمت

  Title Only( د            Title And Content (ج                Title And Text( ب                             Title Slide (الف
۲4 

۲ 
 کنیم؟از طریق کدام منو عمل می  Slide Layout برای دسترسی به پنجره

   Edit( د                                  Tools (ج                                 Insert( ب                                 Format (الف
۲5 

۲ 
 چیست؟ AHو ستون 72آدرس سلول محل برخورد سطر شماره 

 AH:72د(                                AH:72 ج(                                  AH72 ب(                                     72AHالف(
۲6 

۲ 

 منظور از جهت کاغذ در تنظیمات چاپ چیست؟

 یا عمودی چاپ شدن سند روی کاغذافقی  ب(                           جهت وارد شدن کاغذ به چاپگر ( الف   

 . تنظیمی برای جهت کاغذ نداردExcel د(                                    افقی یا عمودی بودن کاربرگ( ج    

۲7 

۲ 
 شود؟ نوارابزار کوچکی که بالا و سمت چپ پنجره اکسل قرار دارد چه نامیده می

   Quick Access Toolbar( د                  Header Toolbar (ج                      Toolbar( ب                  Top Toolbar (الف
۲8 

۲ 
 دارد؟ مجموعه عناصر سازنده هر نمودار )مانند راهنما، جدول مقادیر و عناوین( چه نام

   Chart Set( د                      Layout (ج                     Component Set( ب                 Element Set (الف
۲9 

۲ 

 چهار سطح اولویت عملگرها به ترتیب از زیاد به کم در کدام گزینه صحیح است؟
 جمع و تفریق، عملگرهای منطقی، توان، ضرب و تقسیم ب(                    ضرب و تقسیم، توان، جمع و تفریق، عملگرهای منطقی ( الف    

 عملگرهای منطقی، توان، ضرب و تقسیم، جمع و تفریق  د(                       ضرب و تقسیم، جمع و تفریق، عملگرهای منطقیتوان، ( ج      

3۰ 

۲ 

 کدام گزینه می باشد؟ A5نتیجه اجرای فرمول مقابل در سلول 

 9الف( 

 14ب( 

 15ج( 

 16د( 
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۲ 
 اصلاح است؟ فرض چند کاربرگ در هر کارپوشه جدید وجود دارد؟ آیا این مقدار قابل به طور پیش

 بله - 1( د                                خیر – 1(ج                             بله – 3( ب                            خیر   -  3 (الف
3۲ 

۲ 
 رود چه نام دارد؟ کلمه کلیدی که برای تعیین بزرگنمایی به کار می

   Size Factor( د                                   Size (ج                               Zoom( ب                                 Scale (الف
33 

۲ 
 توان استفاده کرد؟ ها از چه ابزاری می بندی برای کپی کردن قالب

   Formatting Tool( د              Format Transformer (ج                Format Copier( ب            Format Painter (الف
34 

۲ 
Conditional Formatting  به چه مفهومی گفته می شود؟ 

  بندی شرطی قالب( د                     بندی پیشرفته قالب (ج                    بندی قالب( ب           بندی تکرار شونده قالب (الف
35 

۲ 
 شود؟ درج سلول، ردیف یا ستون در کاربرگ با چه کلمه کلیدی شناخته می

 Font( د                                       Format (ج                              Add( ب                                     Insert (الف
36 

۲ 
 کدام گزینه پسوند فایل های اکسل می باشد؟ 

 xlsx.* د(                                          dlsx.* ج(                        accdb.*ب(                                     dxls.*الف ( 
37 

۲ 
 .دهند ای از ....................... مرتبط به هم یک ....................... را تشکیل می مجموعه

 رکورد -های جدول( د                          رکورد –فیلدهای (ج             فیلد -رکوردهای( ب                    جدول –فیلدهای (الف
38 

۲ 
 .کند فراهم می بانک اطلاعاتی  ها را در جدول نمای ......................... امکان ورود و ویرایش داده

 Pivot table( د                        Pivot chart (ج                               Design( ب                         Datasheet (الف
39 

۲ 
 گذاری فیلدها مجاز است؟ دام کاراکتر در نامک

   نقطه( د                                       ! (ج                                           &( ب                                          [ (الف
4۰ 

۲ 
 دهد؟ درایجاد جدول، کدام امکان را در اختیار کاربر قرار نمی  DataSheet استفاده ازنمای

    اضافه کردن رکورد( د                       تعیین کلید اصلی (ج                   یدتعریف فیلد جد( ب                    حذف فیلد (الف
41 

۲ 
 رود؟ وجو به کار می برای ساختن پرس Create ی کدام گروه از زبانه

 Query( د                              DataSheet (ج                                    Other( ب                       Design (الف
4۲ 

۲ 
 شود؟ شوند از کدام معیار استفاده می شروع می  A برای بازیابی تمام مقادیری که با حرف

  *Like* A( د                                  *Like A (ج                                    Like A( ب                     Like * A (الف
43 

۲ 
 رود؟ ها به کار میشرط گذاری روی فیلدوجو برای  کدام گزینه در صفحه طراحی پرس

 Filde( د                                     Show (ج                                       Sort( ب                     Criteria (الف
44 

۲ 
   در کدام نما رکوردها نمایش داده نمی شوند؟

 Form View( د                       Design View (ج                   Layout View( ب                  Pivot Table (الف
45 

۲ 
 های مرحله به مرحله از کاربر اقدام به ایجاد گزارش می کند؟ ایجاد گزارش با طرح پرسشکدام روش 

 Chart Wizard( د                       Report Wizard (ج                Label Wizard( ب                     Report Tool (الف
46 

۲ 

ک به چند ، چند به چند(  را یبا توجه به جداول و فیلد های هر جدول ارتباط بین جداول و همچنین نوع ارتباط)یک به یک، 

 مشخص کنید. )با رسم خط بین جداول(
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۲ 

 اضافه است(مورد  1). مقابل آن بنویسید و های سمت راست را از ستون سمت چپ انتخاب کرده عادل عبارتم

 حذف فیلتر از جدول برای یا گزینه  )                                                       (                                          Input Mask 

 ای برای ثابت سازی محل ستون گزینه    )                                                       (                        Rename Columns 

 داده )                                                       (       مشخصه ای برای تعیین الگوی ورود                           Toggle Filter 

 ای برای تغییر نام ستون گزینه     )                                                       (                                                   Required 
Freeze Columns 

48 

۲ 

 را نام برده و هر کدام را توضیح دهید؟ Access 2007چهار مورد از نوع داده های موجود در بانک اطلاعاتی 

 

 

 

 

 

 

 

 

49 

۲ 

 معنی لغات زیر را بنویسید.

Paper Orientation( ............................................. )         

Column ( ............................................. )      

Create ( ............................................. )      

Template ( ........................................ ) 

5۰ 

موفق و سربلند باشید.موفقیت در آزمون حاصل تلاش مستمر در طول سال تحصیلی است  نه شب امتحان.   1۰۰   

 

 .دیمراجعه نمای ramfan.ir رامیار فناور به نشانی پاسخنامه به سایتفایل سوالات به همراه فت یاجهت در
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 پاسخنامه
 اداره کل آموزش وپرورش شهرستانهای استان تهران

 مدیریت آموزش وپرورش شهرستان قدس

 1 هنرستان کاردانش شهید آوینی - 14۰1- 14۰۲سال تحصیلی   خرداد ماه امتحانات

 اتوماسیون ادارینام درس: کاربر                سرکانیرشته: تصویر سازی دیجیتال        نام دبیر :             دهم کلاس/پایه: 

 ۲از  1دقیقه                                    صفحه :     8۰مدت امتحان:              14۰۲/ ۰3  /۲۰تاریخ امتحان: 

 

 

 
 

 

 

 

 

 

 

 

 

 

 د ج ب الف سوال  د ج ب الف سوال

1     24     

2     25     

3     26     

4     27     

5     28     

6     29     

7     30     

8     31     

9     32     

10     33     

11     34     

12     35     

13     36     

14     37     

15     38     

16     39     

17     40     

18     41     

19     42     

20     43     

21     44     

22     45     

23     46     

 

 

 

 

 



6 

 

 

 

 

 

 

47 

 
 
 

 

48 

 حذف فیلتر از جدولبرای  ی ا گزینه         (Toggle Filter       )                          

 سازی محل ستونای برای ثابت  گزینه    (Freeze Columns        )           

 مشخصه ای برای تعیین الگوی ورود     ( دادهInput Mask                   ) 

 ای برای تغییر نام ستون گزینه     (Rename Columns                                  ) 

49 
 : ازعبارتند  Access 2007انواع داده های موجود در 

Text ،Memo ،Number ،Date / Time ، Currency، Auto Number،Yes / No ،OLE objects ،Hyperlink ،Attachment   

50 

 Paper Orientation جهت کاغذ
 Column ستون

 Create ایجاد کردن
 Template الگو


